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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.
License types
Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.
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Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note,
unless otherwise stated, that each Instance of a product must be
separately licensed and ordered. For example, if the end user
customer or Avaya Channel Partner would like to install two
Instances of the same type of products, then two products of that
type must be ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE

AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC
VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS ENCODED
BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
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All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.



Contents

Chapter 1: Introduction............................................................................................................  8
Purpose.................................................................................................................................. 8
Change history........................................................................................................................ 8

Chapter 2: Getting started...................................................................................................... 11
IP Office Contact Center Web User Interface requirements....................................................... 12
Web browser certificate configuration...................................................................................... 13

Configuring Google Chrome to accept certificates on a Chrome device...............................  13
Configuring Google Chrome to accept certificates on Windows...........................................  14
Configuring Google Chrome to accept certificates on macOS.............................................  15
Configuring Internet Explorer to accept certificates on Windows..........................................  15
Configuring Firefox to accept certificates on Windows and macOS......................................  16
Configuring Safari to accept certificates on macOS............................................................  17

Adding a certificate to Keychain Access on macOS.................................................................. 18
Logging in to the user interface............................................................................................... 18
Logging out of the interface....................................................................................................  20
Changing your password.......................................................................................................  20
Updating notification settings.................................................................................................. 21

Chapter 3: Navigation............................................................................................................. 22
General interface options.......................................................................................................  22
Functionality and statistics.....................................................................................................  22

Agent and supervisor Home screen functionality................................................................  22
Telephony screen functionality.......................................................................................... 25
Email and chat functionality.............................................................................................. 27
Supervisor Realtime Information and Reporting functionality...............................................  28

Part 1: Agent operations.................................................................................................  30
Chapter 4: General agent operations.............................................................................. 31

Signing in and out of agent groups.................................................................................... 31
Viewing agent work states and other agent group details....................................................  32

Agent work states...................................................................................................... 32
Starting and ending a break.............................................................................................  33

Agent break and work statistics..................................................................................  34
Break policies and restrictions....................................................................................  34

Working with customer details..........................................................................................  35
Chapter 5: Telephony.......................................................................................................  37

Outbound dialer calls.......................................................................................................  37
Call response and qualification types..........................................................................  38

Managing calls in the user interface..................................................................................  39
Answering calls.........................................................................................................  39
Making a call............................................................................................................. 39

March 2019 Using the Avaya IP Office Contact Center Web Interface 5
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the Avaya IP Office Contact Center Web Interface


Making conference calls............................................................................................. 40
Putting calls on hold..................................................................................................  40
Entering digits during a call........................................................................................  41
Transferring calls....................................................................................................... 41
Requesting supervisor support during a call................................................................  41
Ending calls..............................................................................................................  42

Chapter 6: Email and chat................................................................................................ 43
Email operations.............................................................................................................  43

Searching for emails..................................................................................................  44
Activating or picking up an email................................................................................. 44
Creating, replying to, and forwarding emails................................................................  45
Saving an email draft.................................................................................................  45
Selecting a job code..................................................................................................  46
Changing the status of an email.................................................................................. 46
Reassigning an email................................................................................................  47

Chat operations............................................................................................................... 48
Replying to a chat conversation..................................................................................  48
Starting a chat consultation........................................................................................  49
Chat transfers...........................................................................................................  49
Enabling and disabling spell checks for chat................................................................  50
Ending a chat............................................................................................................ 51
Searching for archived conversations.......................................................................... 52

Part 2: Supervisor operations.......................................................................................  53
Chapter 7: Real time information....................................................................................  54

Viewing agent and group information in real time...............................................................  54
Assigning calls from the queue.........................................................................................  56
Monitoring an agent call silently........................................................................................  57
Joining a call when an agent requests emergency assistance.............................................  57
Viewing variables............................................................................................................  58

Chapter 8: Reports............................................................................................................ 59
Report types...................................................................................................................  59
Viewing existing reports...................................................................................................  60
Generating a report.........................................................................................................  60
Managing and exporting reports.......................................................................................  61

Chapter 9: Agent status and contact detail reports......................................................  63
Agent status report data................................................................................................... 64
Contact detail report data.................................................................................................  64

Additional details.......................................................................................................  66
Appendix A: Resources.........................................................................................................  69

Documentation...................................................................................................................... 69
Finding documents on the Avaya Support website.............................................................  70

Viewing Avaya Mentor videos................................................................................................. 70

Contents

March 2019 Using the Avaya IP Office Contact Center Web Interface 6
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the Avaya IP Office Contact Center Web Interface


Support................................................................................................................................  71
Using the Avaya InSite Knowledge Base...........................................................................  71

Glossary................................................................................................................................... 72

Contents

March 2019 Using the Avaya IP Office Contact Center Web Interface 7
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the Avaya IP Office Contact Center Web Interface


Chapter 1: Introduction

Purpose
This document provides contextual information and procedures for using Agent and Supervisor
functionality in the IP Office Contact Center Web User Interface.

Administration functionality is not available on this interface. You can perform administration tasks
using the IP Office Contact Center User Interface for Windows or the IP Office Contact Center web
administration portal.

Change history

Issue Date Summary of changes
Release
10.1,
Issue 1

May 2017 • Listed Windows 10 as a supported operating system.

• Rephrased a few notes and descriptions in the “Navigation” chapter.

• Added a note about the Emergency and Silent Monitoring options in 
Monitoring an agent call silently on page 57.

• Added a note about file name restrictions in Creating, replying to, and
forwarding emails on page 45.

• Added information about chat transfer and consultation.

• Added information about the Previous Report View option.

Table continues…

March 2019 Using the Avaya IP Office Contact Center Web Interface 8
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the Avaya IP Office Contact Center Web Interface


Issue Date Summary of changes
Release
10.1.1,
Issue 2

October 2017 • Changed the title of this document.

• Removed IP Office Contact Center User Interface for Chrome Devices
references. Other names for this interface include “Chrome App” and
“Chrome UI”. All of these references have been removed.

• Removed the section about managing calls with a Plantronics headset
because this section does not apply to the IP Office Contact Center Web
User Interface.

• Updated IP Office Contact Center Web User Interface requirements on
page 12 with information about Chromebook support.

• Updated the browser certificate configuration procedures under Web
browser certificate configuration on page 13.

• Added Changing your password on page 20.

• Added Updating notification settings on page 21.

• Updated “Before you begin” in Requesting supervisor support during a
call on page 41 to indicate that the call should not be on hold when an
agent requests emergency assistance.

• Added Setting the appropriate language for spell checks on page 51.

• Updated “About this task” in Ending a chat on page 51.

• Split up the supervisor information about monitoring calls silently and
joining calls when an agent requests emergency assistance. For more
information, see Monitoring an agent call silently on page 57 and 
Joining a call when an agent requests emergency assistance on
page 57.

• Added more detail to the steps in Joining a call when an agent requests
emergency assistance on page 57.

• Reorganized reporting information and added Managing and exporting
reports on page 61.

• Added a new chapter: Agent status and contact detail reports on
page 63.

Table continues…

Change history
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Issue Date Summary of changes
Release
10.1.2,
Issue 3

April 2018 • Updated the descriptions in Home screen statistics for agents and
supervisors on page 23.

• Updated the descriptions in Telephony screen functionality on page 25.

• Updated the descriptions in Email and chat functionality on page 27.

• Updated the information about tabs in the Realtime Information module in 
Supervisor Realtime Information and Reporting functionality on page 28.

• Updated Break policies and restrictions on page 34 to indicate that an
administrator can choose to allow breaks during sign off prevention.

• Updated Working with customer details on page 35 to indicate that
configured call tags are displayed.

• Updated Making a call on page 39.

• Updated the procedure in Viewing agent and group information in real
time on page 54.

• Added Viewing variables on page 58.

• Updated the sections under Agent status and contact detail reports on
page 63.

• Updated Documentation on page 69.
Release
10.1.2,
Issue 4

March 2019 Corrected the table in IP Office Contact Center Web User Interface
requirements on page 12.

Introduction
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Chapter 2: Getting started

With the IP Office Contact Center Web User Interface, you can access and use IP Office Contact
Center Agent and Supervisor functionality. You can define users and change user privileges with IP
Office Contact Center User Interface for Windows.

The following table summarizes Agent and Supervisor functionality. Depending on your privileges,
some functionality might be unavailable.

Agent functionality Supervisor functionality
• Access a Home screen to view statistics and sign

in to your agent groups. As an agent, you cannot
send messages from the Home screen.

Telephony statistics include the service factor, the
number of abandoned calls, and the number of
calls in the queue.

• View supervisor messages and other agent
statistics. Agent statistics display the number of
logged in agents and the work state of each agent.
You can also view the number of logged in
supervisors.

• From the Telephony screen, make, receive, and
manage calls. You can make an outbound call
while you are not on a call or in the After Call Work
(ACW) state.

Note:

Video calls are not currently supported.

• During a call, you can write notes, view customer
history, and access configured websites. You can
also request supervisor assistance.

• Use email and chat functionality if configured by
your system administrator. If email and chat
functionality are not configured, the Email and Chat
tabs are not available in the UI.

• Start and end breaks.

• Access a Home screen that provides similar
functionality as the Home screen for agents. As a
supervisor, you can also send messages to agents
from the Home screen.

• Access a Realtime Information screen to monitor
groups, agents, and queues. You can expand
these items to view details. For example, if you
expand an agent group, you can see the current
customer service statistics and the status of all
agents in the group. You can also change the
value of different variables.

• View and generate historical reports from the
Reporting screen. An administrator must configure
the types of reports that you can generate from the
UI. You can change report parameters, such as
date ranges, before generating a new report.

• Act as an agent to perform customer service tasks,
such as answering an incoming call.

• Monitor an active call silently or join the call. To join
a call, you must accept the emergency assistance
request from the agent. If the agent did not make
an emergency assistance request, you can only
monitor the call silently.

• Force an agent to:

- Sign in to or out of specific groups.

- Take a break.
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IP Office Contact Center Web User Interface requirements
The IP Office Contact Center Web User Interface has the following minimum requirements:

• Screen resolution: 1280 x 850 pixels on most devices, except for Chromebooks, which
require 1366 x 768 pixels or higher.

• Memory: 4 GB.
The IP Office Contact Center Web User Interface does not support adaptive sizing. The layout
depends on the size of your browser window.
The IP Office Contact Center Web User Interface is supported on various web browsers. Each
browser supports different phones and operating systems. The following table lists supported
browsers and shows what the IP Office Contact Center Web User Interface supports with each
browser. For more information about interoperability, see https://secureservices.avaya.com/
compatibility-matrix/menus/product.xhtml?name=IP+Office+Contact+Center.

Important:
Avaya recommends using the latest browser versions. Make sure your browser is updated to
the latest available patch.

Web browser Supported
operating systems

WebRTC
support

Desk phone
support

Avaya
Communicator
for Windows
soft phone
support

Internet Explorer (IE) 1 • Windows 7

• Windows 8.1

• Windows 10

No Yes Yes

Google Chrome • Windows 7

• Windows 8.1

• Windows 10

• Mac OS X 10.10

• Chromebooks
with Chrome OS
version 37 or later

Yes Yes Yes

Mozilla Firefox • Windows 7

• Windows 8.1

• Windows 10

• Mac OS X 10.10

No Yes Yes

Safari • Mac OS X 10.10 No Yes No

1 If you are using IE 11 through an intranet connection, ensure the Display intranet sites in Compatibility View check
box in the Compatibility View Settings dialog box is not selected.

Getting started
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Web browser certificate configuration
The following procedures describe how to enable your browser to accept IP Office Contact Center
certificates. The instructions for Google Chrome vary for the Chrome Device, Windows, and
macOS. The instructions for Internet Explorer and Firefox are the same for Windows and macOS.

Important:
• You do not need to perform this task if your administrator has installed a genuine

certificate from a trusted certificate authority (CA).

• All users on the same computer must configure their browser to accept IP Office Contact
Center certificates.

Configuring Google Chrome to accept certificates on a Chrome
device

About this task
Use this procedure if you are using a Chromebook. Before you install the required certificate, your
browser displays the warning Your connection is not private.

Procedure
1. In Google Chrome, enter https://xxx.xxx.xxx:28443/WebUI.

Replace xxx.xxx.xxx with the host name or the IP address of the IP Office Contact
Center server.

2. At the top of the browser window, click  > More tools > Developer tools.

3. On the Security tab, in the Security Overview area, click View certificate.

4. In the Certificate Viewer dialog box, click Details.

5. Click the certificate name, ipoffice-Root, and then click Export.

6. In the Save file as window, do the following:

a. Choose a location to save the certificate.

b. Type a name for the certificate.

c. Select Bas64-encoded ASCII, single certificate from the drop-down list.

d. Click Save.

7. In the Chrome browser, click Tools > Settings.

8. Scroll down to the Advanced area and click Manage certificates.

9. Click the Authorities tab.

10. Click Import and select All Files.

Web browser certificate configuration
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11. Select the certificate exported earlier and then click Open.

12. Select Trust this certificate for identifying websites and click OK.

The device displays the Avaya certificate.

13. Click Done and then close all open windows and browser sessions.

Configuring Google Chrome to accept certificates on Windows
Procedure

1. In Google Chrome, enter https://xxx.xxx.xxx:28443/WebUI.

Replace xxx.xxx.xxx with the host name or the IP address of the IP Office Contact
Center server.

2. Do the following to view certificates:

a. At the top of the browser window, click .

b. Click More Tools > Developer Tools > Security.

c. On the Security Overview page, click View certificate.

3. In the Certificate dialog box:

a. Click the Certification Path tab.

b. Click the first node in the tree.

c. Click View Certificate.

4. In the next Certificate dialog box:

a. Click the Details tab.

b. Click Copy to file.

5. In the Wizard that displays:

a. Click Next twice.

b. To choose a folder, click Browse and enter a file name.

c. Save your changes.

d. Click Next > Finish.

6. When prompted to close all dialog boxes, click OK and exit the browser.

7. In Windows Explorer, locate the file that you saved, and then do the following:

a. Right-click the file and click Install certificate.

b. Click Next.
c. Click Place all certificates in the following store.

d. Click Browse > Trusted Root Certification Authorities.

Getting started
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e. Click OK > Next > Finish.

f. In the Warning dialog box, click Yes > OK.

8. (Optional) Delete the file that you created.

Result
You can now browse the application website without certificate warnings using the host name.
If you use the IP address, the system displays a certificate error next to the address bar and might
produce an error at login.

Configuring Google Chrome to accept certificates on macOS
Procedure

1. In Google Chrome, enter https://xxx.xxx.xxx:28443/WebUI.

Replace xxx.xxx.xxx with the host name or the IP address of the IP Office Contact
Center server.

2. At the top of the browser window, click  > Settings.

3. Scroll down to the Advanced area and click Manage Certificates.

4. In the left navigation pane, do the following:

a. In the Keychains area, click Login.

b. In the Category area, click Certificates.

5. From the File menu, click Import Items.

6. In the displayed dialog box, navigate to the location of your saved file and click Open.

7. If prompted, enter the key pair password and click OK.

Configuring Internet Explorer to accept certificates on Windows
Procedure

1. In Internet Explorer, enter https://xxx.xxx.xxx:28443/WebUI.

Replace xxx.xxx.xxx with the host name or the IP address of the IP Office Contact
Center server.

2. Do the following to view certificates:

a. In the browser window, click Continue to this website.

b. Next to the address bar, click Certificate error.
c. Click View certificates.

Web browser certificate configuration
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3. In the Certificate dialog box:

a. Click the Certification Path tab.

b. Click the first node in the tree.

c. Click View Certificate.

4. In the next Certificate dialog box:

a. Click the Details tab.

b. Click Copy to file.

5. In the Wizard that displays:

a. Click Next twice.

b. To choose a folder, click Browse and enter a file name.

c. Save your changes.

d. Click Next > Finish.

6. When prompted to close all dialog boxes, click OK and exit the browser.

7. In Windows Explorer, locate the file that you saved, and then do the following:

a. Right-click the file and click Install certificate.

b. Click Next.
c. Click Place all certificates in the following store.

d. Click Browse > Trusted Root Certification Authorities.

e. Click OK > Next > Finish.

f. In the Warning dialog box, click Yes > OK.

8. (Optional) Delete the file that you created.

Result
You can now browse the application website without certificate warnings using the host name.
If you use the IP address, the system displays a certificate error next to the address bar and might
produce an error at login.

Configuring Firefox to accept certificates on Windows and macOS
Procedure

1. In Firefox, enter https://xxx.xxx.xxx:28443/WebUI.

Replace xxx.xxx.xxx with the host name or the IP address of the IP Office Contact
Center server.

2. On the Insecure Connection page that is displayed, click Advanced > Add Exception.

Getting started
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3. In the dialog box, click View.

4. In the next dialog box:

a. Click the Details tab.

b. To highlight the top row, in the Certificate Hierarchy area, click the top root node.

c. Click Export.
d. Select a folder and ensure that the file has a .crt extension.

e. Click Save > Close.

f. Click Confirm Security Exception.

5. Select Options from the Tools menu or next to the toolbar.

6. In the left navigation pane, click Advanced.

7. Click Certificates > View Certificates.

8. From the Authorities tab, do the following:

a. Click Import.
b. Select the file that you created and then click Open.

9. In the dialog box, do the following:

a. Select Trust this CA to identify web sites.

b. Click OK, close the dialog boxes, and then exit the browser.

10. (Optional) Delete the file that you created.

Result
You can now browse the application website without certificate warnings using the host name.
If you use the IP address, the system displays a certificate error next to the address bar and might
produce an error at login.

Configuring Safari to accept certificates on macOS
Procedure

1. In Safari, enter https://xxx.xxx.xxx:28443/WebUI.

Replace xxx.xxx.xxx with the host name or the IP address of the IP Office Contact
Center server.

2. Click Show Certificate in the Warning window.

3. Select the Always trust check box.

4. Click Continue.

5. Enter your operating system password to confirm the Certificate Trust Settings change.

Web browser certificate configuration
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6. Click Update Settings.

Result
In the future, the browser will trust the certificate from the IP Office Contact Center server.

Adding a certificate to Keychain Access on macOS
About this task
Use this procedure if you already have the certificate .cer file. This procedure describes how to
install your certificate in Keychain Access.

Procedure
1. Open Keychain Access from your Mac computer.

2. At the bottom of the screen, click .

3. Navigate to the location of the saved certificate.

4. Select the certificate .cer file.

Result
The certificate is added to Keychain Access.

Logging in to the user interface
About this task
Use this procedure to log in to the UI.

Warning:
If the UI or browser crash or are closed before you log out, an improper session logout can
occur and the logout process will not be properly completed on the server. When this situation
occurs, wait for approximately three minutes before you log in to the UI again to avoid an
unexpected logout. The following additional scenarios can cause this situation to occur:

• You perform a forced refresh using the F5 key.

• You try to open a new URL in the same browser window or tab where the UI is running.
• You use the browser option to go back or forward one page.

Before you begin
• Obtain the IP Office server address from your system administrator.
• If you plan to use WebRTC, your administrator must enable the Sync Service. Otherwise, the

UI will not be able to retrieve your WebRTC settings.

Getting started
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• After an upgrade, clear your browser cache. With most browsers, except Safari, you can use
the Ctrl + Shift + Delete keyboard shortcut and then select the appropriate check box
for your browser. With Safari, this keyboard shortcut is not available, so you must clear the
cache from the browser settings.

Procedure
1. Navigate to https://<Server address>:28443/WebUI in your browser:

If you are upgrading from a release prior to Release 10.0, you can choose to use the non-
secure http://<Server address>:28080/WebUI URL. Otherwise, only the secure
HTTPS URL will work. The non-secure HTTP connection is also blocked by the Cloud
firewall and it cannot be used if you are using WebRTC.

Important:

For the HTTPS URL to work in Safari browsers, you must install the required IP Office
Contact Center certificate in your Trusted store.

2. To change the application settings, do the following on the Login screen:

a. Click Settings ( ).

b. Enter the IP address of the IP Office Contact Center server.

c. Enter the IP Office Contact Center server port number.

d. To use WebRTC, change the slider to green, and enter the IP address and port
number of the WebRTC gateway.

e. (Optional) Change the logging level.

Warning is selected by default.

f. Click Save.

3. On the Login screen, enter the following information:

a. Your agent or supervisor user name.

b. Your agent or supervisor password.

c. Your telephone extension number.

If you are using the WebRTC Gateway, the Extension field is replaced by the following:

• Phone Extension: The integrated phone extension.

• Phone Password: The integrated phone password.

Note:

After three failed login attempts, you are locked out for a predefined time. You can ask
your administrator to reset your password to unlock your user ID. By default, the
lockout time is set to 60 seconds and you can attempt to log in 3 times before you are
locked out. The lockout time can be changed by an administrator in the IP Office
Contact Center User Interface for Windows Configuration module.

Logging in to the user interface
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If you are using WebRTC, the number of invalid login attempts also follows the IP
Office configuration. If that number is exceeded, the error message SIP server is
not responding will be displayed.

4. Click Login or press Enter on your keyboard.

Next steps
Sign in to your agent groups.

Related links
Signing in and out of agent groups on page 31

Logging out of the interface
About this task
Use this procedure to log out of the UI when your work shift ends. After you log out, you cannot
receive calls until you sign in to your agent groups again.
You cannot log out while you are on an active call. The system automatically signs you out of all
agent groups if you do not answer an incoming call in the required time.

Procedure
1. In the left navigation pane, click .

2. Click Log out.
3. Click Close ( ) to exit the UI.

Changing your password
About this task
Your password must consist of at least 8 characters from two or more of the following groups:

• Lower case letters
• Capital letters
• Numbers
• Special characters (!, @, #, $, %, ^, &, *)

Before you begin
Ensure that you have the required privilege to change passwords.

Getting started
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Procedure
1. In the left navigation pane, click .

2. Click Change Password.

3. In the Change Password window, do the following:

a. Enter your old password.

b. Enter your new password and confirm it.

4. Click OK.

Updating notification settings
About this task
Use this procedure to update the notification settings that are displayed when the UI is minimized
or hidden. The notification options that you can set depend on what your administrator has
configured in the Configuration module.

Note:
• Notifications are not supported in Internet Explorer (IE). If you are using IE, you can

install an add-in from http://ie-web-notifications.github.io, or if you cannot install add-ins,
you can set up pinned web sites using the instructions at https://msdn.microsoft.com/en-
us/library/gg618532(v=vs.85).aspx. By pinning web sites, an image can be overlaid on
the task bar for any task notification and the notification also flashes. You cannot use
both the add-in and pinned web site options together.

• If the setting to show or block notifications keeps appearing in your browser, a Google
Chrome administrative policy might be in force on the system. Contact your site
administrator if you experience this problem.

Before you begin
You must have the “Change audio/visual notification” privilege.

Procedure
1. In the left navigation pane, click .

2. Use the Visual notifications and Audio notifications switches to enable or disable one
or both notification options.

Important:

You can only set the options that your administrator has configured in the
Configuration module. For example, if your administrator has only configured visual
notifications, then you cannot enable audio notifications in the UI.

Updating notification settings
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Chapter 3: Navigation

General interface options
The following tables display key buttons and options in the UI. You might need to click More ( )
to access some options.

General options

Button Name Description
Settings Enables you to configure the server settings when

you log in to the UI. If you are using WebRTC, you
must also include the WebRTC settings information.

Information Displays release information, including the version
installed.

Agent and supervisor menus

Button Name
Home

Telephony

Email

Chat

Includes a menu for Realtime information, Reporting, Agent Status
Reports, and Contact Detail Reports.

Functionality and statistics

Agent and supervisor Home screen functionality
The following table describes the general options you can access on the Home screen:
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Option Description
Group sign in area You can sign in to all your agent groups or select specific groups.
Messages Agents can view messages from the supervisor.

Supervisors can send messages to agents.
Statistics You can view general statistics, such as overall service levels and the

average wait time for calls. You can also view the number of logged-in
agents and supervisors.

Home screen statistics for agents and supervisors
The statistics on the Home screen are the same for agents and supervisors. All values displayed
on this screen are for the overall contact center and are calculated by taking the average for all
topics in the contact center.

Note:
Some statistics might not match what is displayed in the IP Office Contact Center User
Interface for Windows. For example, the average wait time does not coincide with the value in
the IP Office Contact Center User Interface for Windows. The IP Office Contact Center Web
User Interface shows the average wait time for all topics in which telephony, email, or chat are
enabled. The IP Office Contact Center User Interface for Windows shows the average time for
individual topics.

The following tables describe the key telephony, email, and chat statistics on the Home screen.

Telephony statistics on the Home screen
Statistic Description
Abandoned call monitor The percentage of calls that were abandoned out of the total

calls for each shift.
Service factor The task service factor. This value is displayed as a percentage

and indicates the overall quality of service.
Longest wait time The longest wait time for a call in the queue. This value is

calculated based on all topics in the contact center.
Average wait time The average wait time for calls in the queue.

The formula used to calculate this value is the sum of the
average wait time of topics for which Telephony is enabled
divided by the number of such topics. Topics with an average
wait time of 0 are not considered.

Current active calls The number of active conversations through call distribution.

Note:

For this statistic to work, an administrator must configure a
virtual agent group with the name ChromeAppAG. Virtual
agent groups can be configured in the IP Office Contact
Center User Interface for Windows.

Table continues…
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Statistic Description
Average active calls The average number of active conversations through call

distribution. This average is calculated based on the time range
configured in the IP Office Contact Center User Interface for
Windows Administration tab under Configuration > System >
Real time information default values > Calculating time
period.

Note:

For this statistic to work, an administrator must configure a
virtual agent group with the name ChromeAppAG. Virtual
agent groups can be configured in the IP Office Contact
Center User Interface for Windows.

Answered calls The number of conversations per shift.
Abandoned calls The number of abandoned calls per shift.
Logged in agents or supervisors The number of logged-in agents or supervisors for telephony.

Chat statistics on the Home screen
Statistic Description
Service factor The task service factor. This value is displayed as a percentage

and indicates the overall quality of service.
Longest wait time The longest wait time for an IM conversation in the queue. This

value is calculated based on all topics in the contact center.
Average wait time The average wait time for an IM conversation in the queue.

The formula used to calculate this value is the sum of the
average wait time of topics for which Chat is enabled divided by
the number of such topics. Topics with an average wait time of 0
are not considered.

Chats waiting The number of waiting or pending IM conversations.
Logged in agents or supervisors The number of logged-in agents or supervisors for chat.

Email statistics on the Home screen
Statistic Description
Service factor The task service factor. This value is displayed as a percentage

and indicates the overall quality of service.
Longest wait time The longest wait time for emails in the queue. This value is

calculated based on all topics in the contact center.
Average wait time The average wait time for emails in the queue.

The formula used to calculate this value is the sum of the
average wait time of topics for which Email is enabled divided by
the number of such topics. Topics with an average wait time of 0
are not considered.

Table continues…
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Statistic Description
Emails waiting The number of waiting or pending emails.
Logged in agents or supervisors The number of logged-in agents or supervisors for email.

Telephony screen functionality
The following table describes the general options you can access in the Telephony screen.

Option Description
Call area Displays the following:

• Active calls.

• Actions available for all calls.

Note:

After a customer leaves a conference call, the customer name is still
displayed. If customer information is unavailable, nothing displays on
the UI. The area where the customer name is usually displayed
remains blank.

Content area Displays the following:

• Customer Details: Customer history, notes about customer issues, and
an option to search for information on the internet.

• Groups tab: Agent group statistics displaying the number of agents
signed in to each channel. You can also sign in to or sign out of agent
groups.

• Topics tab: Telephony topic statistics. For each topic, you can see
Customers Waiting and Abandoned Calls. The Abandoned Calls tab
shows calls dropped by the customer under Abandoned Calls, and calls
dropped by IP Office Contact Center based on the task flow
configuration under Call Dropped. By default, the task flow is configured
to drop calls if the queue is full.

Note:

You can only reserve a call when the call is in the queue. You can
pick up a queued call from the Customers Waiting area in the
Topics tab.

• Users tab: A list of agents, their statuses, and the actions available for
each agent. You can also view a complete list of names and contact
numbers for the entire contact center.

Table continues…

Functionality and statistics
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Option Description
Tertiary information Displays telephony statistics, including:

• Answered calls.

• Outbound dialer calls.

• Average talk time.

• Incoming calls per hour, which are calculated and extrapolated.

Note:

The placed or outbound calls counter is increased for Direct Dialer,
Campaign Dialer, and Agent Dialer calls, but not for Mechanic Dialer
calls.

Telephony users
In the Telephony > Users tab, you can view the following:

• Agents
• Contacts

Agents tab options

Name Description
Agent names and extensions You can view a list of agent names and extension numbers. You can also

search for agents by name.
Agent status information Agents work states include the following:

• Signed off

• Available

• Do not disturb (DND)

• Busy

Contacts tab options

Name Description
Search Contacts field Enables you to search for IP Office users by contact number.
User names and phone
numbers

The UI displays a list of user names and phone number. You can also use
the Phone button ( ) to call a user.

Telephony screen statistics for agents
The statistics on the Telephony screen are customized for the agent. Each statistic is based on the
agent’s performance during a shift. General statistics for the whole contact center are available on
the Home screen.

Navigation
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Statistic Description
Answered calls The number of conversations that the agent addressed during

the shift.
Outbound dialer calls The number of outgoing calls per shift.
Average talk time The average conversation length per shift.
Incoming calls per hour The average number of Automatic Call Distribution (ACD) calls

per hour. This value is related to the time when the agent is
signed in during the shift.

Email and chat functionality
Email screen

Option Description
Search and folder views On the left side of the Email screen, you can search for a specific email

message or switch the folder view.
Email list The left side of the Email screen displays the email issues that are

assigned to you.
Reading pane and email
actions

When you select an email, the email message displays on the right side
of the screen.

After activating the email, you can access actions such as Reply,
Forward, Add attachment, and Send. You might need to click More ( )
to view some options.

Customer details At the bottom of an email message, you can view customer details.

Chat screen

Option Description
Assigned chats tab On the left side of the screen, you can see all of the open chat or IM

conversations assigned to you. When you select a chat, the content
displays on the right side of the screen. You can type messages, perform
consultations or transfers, and end the chat session. You can choose to
print the chat conversation before ending it.

Customer details At the bottom of a chat conversation assigned to you, you can view
customer details.

Archived chats tab After you end an IM conversation, the conversation is stored in the
Archived chats tab. You can use this tab to search for archived
conversations on your server. You can also view other agents’
conversations.

Functionality and statistics
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Supervisor Realtime Information and Reporting functionality
Supervisors can access agent functionality and the following additional functionality:

• Realtime Information
• Reporting

Realtime Information screen

Name Description
Realtime statistics The following tabs are available in the Realtime Information module:

• Agents

• Groups

• Topics

• Queue

• Other

When you click on each category, the system displays a high-level list of
items. You can click each item to view details, such as the current status
of agents or agent groups, details of current calls, and current service
statistics. You can sort and filter the organization of real time information.

Note:

As a supervisor, you can have a maximum total of 25 agents in the
combined groups for which you are authorized.

Reporting screen

Button Description
Choose Report You can select a report type from the available options, which are

configured by your administrator.
View Report You can view the last generated report after you select a report type. The

options are:

• Display the report in full screen mode.

• Download the report.

• Print the report.
Run Report You can generate a new report after you specify the start and end dates

for the reporting period.

You can see the status of the report being generated. You can continue
browsing through reports while the system generates a new report.
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Realtime Information screen statistics for supervisors
The statistics on the Realtime Information screen enable supervisors to monitor real time activities
in the contact center. The statistics on this screen show information at the individual topic or group
level.
The following tables describe the key telephony, email, and chat statistics on the Realtime
Information screen.

Telephony statistics on the Realtime Information screen
Statistic Description
Abandoned call monitor The percentage of calls that were abandoned out of the total calls

for each shift.
Service factor The task service factor. This value is displayed as a percentage

and indicates the overall quality of service.
Longest wait time The longest wait time for a call in the queue.
Average wait time The average wait time for calls in the queue.
Agents available The number of available agents.
Total calls The total number of answered and abandoned calls for each shift.

Chat statistics on the Realtime Information screen
Statistic Description
Longest wait time The longest wait time for an IM conversation in the queue.
Average wait time The average wait time for an IM conversation in the queue.
Chats waiting The number of waiting or pending IM conversations.
Agents available The number of available agents.

Email statistics on the Realtime Information screen
Statistic Description
Longest wait time The longest wait time for emails in the queue.
Average wait time The average wait time for emails in the queue.
Emails waiting The number of waiting or pending emails.
Agents available The number of available agents.
Total activated emails The number of emails that were activated during the shift.

Functionality and statistics
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Part 1: Agent operations
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Chapter 4: General agent operations

This chapter describes general agent tasks that are available for all agents regardless of which
channels they are signed in to. These tasks are not unique to the telephony, email, or chat channels.
General agent tasks include the following:

• Signing in and out of agent groups.
• Taking breaks: This feature is available to all agents regardless of which channels they are

signed in to.
• Working with customer details: You can access customer details and take notes about

customer interactions related to telephony, email, or chat. Some minor differences in
functionality exist depending on whether you are using telephony, email, or chat.

Information that is unique to the telephony, email, and chat channels are not described in this
chapter. You can find this information in the subsequent chapters.

Signing in and out of agent groups
About this task
Use this procedure to manually sign in to and sign out of agent groups. This procedure is not
applicable if your administrator has configured automatic sign in with the IP Office Contact Center
User Interface for Windows.
You can receive calls and, if applicable, emails and IMs from the groups that you are signed in to.
The UI also displays your availability for the telephony, email, and chat channels, and indicates
which channels you are signed in to.

Before you begin
Ensure your administrator has configured the required agent groups and virtual agent groups.

Procedure
1. On the Home screen:

• To join all authorized agent groups, click Join All Groups ( ).
• To select specific groups, click Select Groups ( ).

2. For each agent group, select whether you want to sign in to telephony, email, or chat.

You can sign in to one or more of these channels. You can change the channels selected
for each agent group at any time.
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Note:

If your administrator has not configured the email and chat functionality, then these
options are not available.

3. To sign out of all selected groups, in the Select groups dialog box, click Clear All.

You can also choose to sign out of a specific agent group.

Viewing agent work states and other agent group details
About this task
The Groups tab displays the number of other agents available to answer calls. You can view
information, such as the number of agents logged in and average wait time for calls. With this
information, you can decide when to take a break, sign out, or switch agent groups. You can also
expand individual groups to view detailed information about the group.

Procedure
1. In the left navigation pane, click Telephony ( ).

2. In the content area, click Groups.

The system displays the number of agents signed in to the selected groups.

3. (Optional) To view individual groups, in the agent group, click Expand ( ).

The system displays detailed statistics, including waiting callers.

You can also:

• Reserve a call from the queue.

• Pick up a call.

• Return a call from the list of abandoned calls.

Agent work states
You can filter agents by status. For example, you can choose to only view agents that are set to
“Available”.

Note:
• Logged out agents are not displayed in the UI. If an agent is logged in to the interface,

but not signed in to an agent group, the agent status displays as “Signed off”. The agent
status changes to “Available” when the agent signs in to the group. When the agent logs
out of the interface, the agent is no longer listed in the UI.
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• The “Available” state only appears if an agent is not on break or on a call. “Available” is
overridden by other work states, such as “On Break” and “Busy”.

Channel availability
The UI also uses colors to indicate whether you are signed in to all groups for a channel. In the
following image example, the agent is:

• Signed in to all telephony groups. The agent is fully available on the Telephony channel.
• Signed in to at least one email group. The agent is partially available on the Email channel.
• Not signed in to any groups for chat. The agent is not available on the Chat channel.

Starting and ending a break
About this task
When you request a break, you might be prompted to select a code describing the type and
duration of the break.

Procedure
1. To view your Worked, On Break, and Last Break status, click  in the left navigation pane.

You can see the status information for the telephony, email, and chat channels.

2. To start or end a break, click the button below .

Result

Your request to take a break might not be granted right away. The grey  indicator appears next
to the appropriate channel when your break request is pending.
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When your break is granted, the red  indicator displays next to the channels you are signed in
to. While you are on break:

• You cannot receive contact center calls, emails, or IM chats. You start receiving new calls,
emails, and chats again after you return from break.

• You cannot activate contact center emails. The Activate button becomes available again
when you return from break.

Agent break and work statistics
You can view the following work and break time information for an agent:

UI statistic Description
On Break The time spent on break during the current shift.
Last Break The time since the agent returned from their last break and

resumed work.
Worked The time spent working during the current shift.

Example scenario
An agent works for 40 minutes and then goes on break for 5 minutes. When the agent resumes
work, the Last Break timer resets to 0. If the 5 minute break is the agent’s first break for the shift,
On Break displays 00:05.

After 10 minutes of working:
• Worked displays 00:50. This includes the 40 minutes spent working at the beginning of the

shift plus the 10 minutes spent working since the agent returned from their last break.
• Last Break displays 00:10 because the agent has been working for 10 minutes since the

last break.
• On Break continues to display 00:05 because, so far, the agent only spent 5 minutes on

break during the current shift.

Break policies and restrictions
Your administrator can configure a sign off prevention quota in the IP Office Contact Center User
Interface for Windows or the IP Office Contact Center web administration portal. This quota
defines the minimum number of agents that must remain signed in to agent groups. The
administrator can also specify whether agents can take a break during sign off prevention. Unless
break time is allowed by your administrator, you will not be able to take a break during sign off
prevention.
The following are examples of circumstances that might prevent you from taking a break:

• Call volume is high.
• Multiple agents are already on break. A certain number of agents must always be available.
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• Another break was taken recently.

The grey  indicator appears next to the appropriate channel when your break request is
pending. If you request a break while you are on a call, your break request is granted after the call
is completed. When your break is granted, the red  indicator displays next to the channels you
are signed in to.

Working with customer details
About this task
You can view customer details at the bottom of an email or IM conversation, while you are on an
active call, or during wrap-up time for a call.
You can also:

• Take notes and view notes from other agents.
• View information resources from configured websites.

Before you begin
To perform research on the internet, your administrator must configure the websites you can
access.

Procedure
1. If you are on a call, click Call Details in the content area.

Customer details automatically appear at the bottom of emails and IM conversations.

2. To view general information, click Customer Details ( ).

The following type of information appears if available:

• Name

• Phone number

• Account number

• Priority of the customer

The customer details for a call also display the call tags that your administrator configured
in the IP Office Contact Center User Interface for Windows.

3. To enter notes, click Notes ( ) and describe the customer issues in the text area.

4. To view a history of notes entered by other agents, click History ( ).

Notes are also displayed in the Search tab.

Long notes are partially visible. You might need to expand an entry to read the full note.
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Important:

The History tab is not available for chat. You can use this feature with telephony and
email.

5. To search for additional customer records, such as email exchanges, click Search ( ).

You can search by:

• Telephone number

• Email ID

• Jabber ID

6. To perform research on the internet, click on an available website.

Depending on your system configuration, a browser window or tab might automatically
open in the UI.
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Chapter 5: Telephony

This chapter describes how to perform telephony tasks. For information about general agent
operations, such as working with breaks and customer details, see the “General agent operations”
chapter.

To use telephony functionality, you must enable telephony when you sign in to your agent groups.
From the Telephony screen, you can handle incoming and outgoing calls, and view telephony
statistics for the shift. You can also view customer details while you are on an active call or during
wrap-up time for a call. The customer details for a call also display the call tags that your
administrator configured in the IP Office Contact Center User Interface for Windows. You can only
view call tags in the IP Office Contact Center Web User Interface, but you cannot edit them from this
UI.

Note:

If you lose connection to the server while on a call, the Telephony screen becomes
unresponsive and you might not see the complete call details. After the connection to the server
is restored, you might need to log out and log back in to the UI. If you are using a desk phone,
your call remains connected when you log out of the UI. Call details will appear properly starting
with the next call, but you might not see the correct call details for the current call.

Call duration
While on an active call, you can see the call duration timer. The talk time displayed on the timer is
calculated for the current call. The talk time does not include the time taken for internal transfers and
putting calls in the queue.

Outbound dialer calls
IP Office Contact Center uses the outbound dialer functionality to automatically assign outgoing
calls to agents. An outbound caller ID is generated for each call. Outbound dialer calls can be set
up in the following ways:

• IP Office Contact Center makes the outgoing call automatically. After the connection with the
called party is established, IP Office Contact Center immediately distributes the call to an
agent to handle.

• IP Office Contact Center distributes details about the call to an agent in Preview mode. The
agent can choose to start the call immediately or wait for the pre-announcement to expire.

• IP Office Contact Center makes the outgoing call
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For more information about outbound dialer, see:
• Avaya IP Office Contact Center Feature Description
• Administering Avaya IP Office Contact Center Dialer

Call response and qualification types
When you are on an outbound dialer call, the call area can display one of the following responses.
You must select the appropriate response code at the end of the call.

Outbound dialer call responses

Type of response Description
Call answered by intended
recipient

The recipient answers the call, and you confirm that the person at the
other end is the intended party.

Call answered, but intended
recipient unavailable

The recipient answers the call, and you confirm that the person at the
other end is not the intended party. You can leave a message asking the
intended party to call back and then disconnect the call.

Call answered by voice mail The call is connected and reaches the voice mail box or answering
machine. You can leave a message asking the intended party to call back
and then disconnect the call.

Called number is busy The call is unanswered, and you hear a busy tone. The system tries to
make the call again.

Called number not in service The call is unanswered, and you hear a fast busy tone or an automatic
announcement that the number is not in use.

Call answered by fax machine The call is connected and reaches a fax machine or modem.
No Answer The call is connected, and you hear a call back tone. If the maximum wait

time for an answer is exceeded, the call disconnects automatically. The
system tries to make the call again later.

Wrong Number The recipient answers the call, and you identify that the number is no
longer used by the intended party.

Closure options
You can select closure options defining the outcome of the call. Example of closure options are
described in the following table.
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Option Description

Closure ( )
Specifies that the call was unsuccessful and provides an explanation,
such as:

• Follow up

• Answering machine

• Wrong number

• New number

Closure RPC ( )
Confirms that the job was completed.

Closure as Fax Abandoned

Call ( )

Specifies that a fax machine answered the call.

Managing calls in the user interface

Answering calls
About this task
After you sign in to your agent groups, the Telephony ( ) button on the left flashes if you have an
active call.

Procedure

In the call area, click Answer ( ).

Making a call
About this task
Use this procedure to make calls. If you are using a Chrome OS device, you can choose to
manually dial numbers using the Chrome numeric keyboard.

Procedure
1. In the call area, click Dial ( ).

2. To make a call by dialing a number manually, do the following:

a. In the pop-up menu, click Manual.
b. In the Enter Number field, enter the number or extension.

c. If you want to make an outgoing topic call, select Outgoing ACD call.
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d. Select Internal for a subscriber within the PBX or External for a subscriber outside
the PBX.

e. Select a topic.

Note:

For outgoing ACD calls, you cannot dial a topic number.

f. To start the call, click Phone ( ).

3. To make an internal call to a phone number in your contact list, do the following:

a. In the pop-up menu, click Internal.
b. From the contact list, select the number to dial and then click Phone ( ).

Making conference calls
Before you begin
An active call must be in progress.

Procedure
1. In the call area, click Consultation ( ).

2. In the pop-up menu, do one of the following:

• In the Internal tab, select the appropriate user and then click Phone ( ).

• In the Manual tab, type a destination number in the Enter Number field and click
Phone ( ).

The system establishes a two-party call with the user you called.

3. To establish a three-way conference call, click Conference ( ).

4. (Optional) If there is no response from the third party, click Hang up ( ) to end the call.

Putting calls on hold
Before you begin
An active call must be in progress.

Procedure
1. In the call area, click Hold ( ).

2. To resume the call, click Hold ( ) again.
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Entering digits during a call
About this task
You might need to enter dual-tone multi-frequency (DTMF) digits during certain calls. For example,
in your voice mailbox, you use DTMF digits to enter your login password and select options.

Procedure
1. In the call area, click More ( ).

2. Click DTMF ( ).

3. Select the required digits.

4. Click Close ( ) to close the window.

Transferring calls
About this task
You can perform unsupervised and assisted call transfers. With unsupervised or blind transfers,
you perform the transfer without consulting the party that the call will be transferred to. The call
can be transferred to any topic or agent group. With assisted transfers, you consult the party
before completing the transfer.

Before you begin
An active call must be in progress.

Procedure
1. In the call area, click Consultation ( ).

2. In the pop-up menu, do one of the following:

• In the Internal tab, click Phone ( ).
• In the Manual tab, type a destination number in the Enter Number field and click

Phone ( ).

3. Click Transfer ( ).

4. If the extension is busy, click Hang up ( ) next to the call that you want to drop.

Requesting supervisor support during a call
About this task
During a call with a customer, you can request emergency assistance from a supervisor. The
supervisor joins the call to provide assistance.
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Before you begin
An active call must be in progress and the call cannot be on hold. If the call is on hold, the
supervisor will not be able to join.

Procedure

In the call area, click Emergency ( ).

The Notification ( ) icon turns red and a signal is activated on the supervisor’s interface.

Result
The supervisor can join the call at any time. If the supervisor hangs up, you and the customer
remain connected on the call.

Ending calls
About this task
During wrap-up time, you can select job codes that define the outcome or result of the call. You
cannot receive a new call until you finish selecting job codes.

Note:
During wrap-up time, the Dial button is available only if you have the Extend Wrap-Up
privilege.

Procedure
1. In the call area, click Hang up ( ) to end your call.

Your administrator can configure the system to automatically enter wrap-up time at the end
of a call. A timer shows the amount of time you have by default.

If a job code is mandatory for the call, the Job Codes button flashes until you select a job
code.

2. If your administrator has configured mandatory job codes, select the appropriate job codes
and enter any other required notes for the call.

You can enter a key word in the Search field to find a job code.

3. (Optional) To extend your wrap-up time, click Extend ACW ( ).

4. When you have finished selecting job codes and entering notes for the call, click Finish.

Wrap-up time ends. You can receive new calls.
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Chapter 6: Email and chat

Email operations
You can perform the following tasks from the Email screen if you enable email when you sign in to
your agent groups:

• View unread emails. When you receive a new email, a visual notification displays in the UI.

• Create and send emails.

• Reply to the sender of an email or to all users on the email distribution list.

• Forward an email to one or more people.

• Delete emails. You can only delete topic emails if your administrator has given you the
appropriate privilege.

• Save email drafts. For example, if you start typing an email but cannot finish right away, then
you can save the draft and finish typing the email later.

• Add attachments, such as files and images, to an email before sending it.

• View customer details at the bottom of a customer email.

• Reassign or delegate customer emails to another agent or supervisor.

• Update the status of emails. After you finish addressing a customer action, you can set the
email status to Complete. If you cannot address a customer issue right away, you can set
the email status to Defer and then follow up on the email later.

• Select job codes that define the outcome of the email exchange.

• Print emails.

• View archived emails if your administrator has given you the appropriate privilege.

• Use spell check.

• Use address books.

• Access customer history.
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Searching for emails
About this task
You can search for emails in any folder and sort emails by criteria. The left side of the Email
screen lists the emails that are assigned to you.

Note:
You can only search for keywords in the email subject and not in the email body.

Procedure
1. From the drop-down menu, select the folder that you want to search.

2. In the Search field, type the appropriate keywords.

For example, you can type part of the subject.

Tip:

You might need to click More for the UI to display the latest search results.

3. (Optional) Sort emails based on the available criteria.

You can sort emails by the:

• Date received

• Name of the sender in alphabetical order

• Topic to which the email is allocated in alphabetical order

Activating or picking up an email
About this task
Before you can reply to an inactive email, you must activate it. You can also pick up emails that
you want to address from the Overview folder.

Procedure
• To activate an inactive email, click Activate.

• To pick up an email, from the Overview folder, click Pick ( ).

Note:

In the IP Office Contact Center Web User Interface, the Pick ( ) button is only available
for emails in the queue.
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Creating, replying to, and forwarding emails
About this task
You can create new emails, reply to emails assigned to you, and forward emails. New, unread
emails have a blue indicator, and these emails are considered inactive.
When working with customer emails, you can access available customer details and take notes
about your current interaction. For more information about customer details, see Working with
customer details on page 35.

Before you begin
Before replying to an inactive email, click the Activate button. Reply replaces the Activate button.

Procedure
1. Do one of the following:

• To create a new email, click Compose ( ).

• To reply to the sender of an email, click Reply.

• To reply to everyone on the email distribution list, click More ( ) and then select Reply
all ( ).

• To forward an email to someone, click Forward ( ).

2. If you are creating a new email, enter a subject.

3. Type a message.

4. (Optional) Do one of the following to add an attachment:

• Click Add attachment ( ) and then select the file that you want to attach.

• Drag and drop the file that you want to attach onto the email.

Note:

If you attach a file with & in the file name, the email recipient will not receive the
attachment.

5. When you are ready to send the email, click Send.

Saving an email draft
About this task
If you cannot finish an email right away, you can save a draft and then finish the email later. You
can access saved emails from the Drafts folder.
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Procedure
1. Start typing an email.

2. To save a draft of the email, click Save ( ).

Selecting a job code
About this task
Use this procedure to select a job code. If you already selected a job code, you can also update
your selection. Only one job code can be associated with an email topic.

Before you begin
Your administrator must configure job codes in the IP Office Contact Center User Interface for
Windows. When configuring job codes in the IP Office Contact Center User Interface for Windows,
your administrator can choose whether to make job code selection mandatory or optional.

Procedure
1. Select the appropriate email.

2. Click More ( ).

3. Click Job Codes ( ).

4. Select a job code from the list.

If the topic is configured to use job codes, you can search for a specific job code using the
Search field.

5. Click  to submit your selection.

Result
The job code selected for an email displays in the email header.

Changing the status of an email
Setting an email to Complete

About this task
When configuring job codes in the IP Office Contact Center User Interface for Windows, your
administrator can choose whether to make job code selection mandatory or optional. If job code
selection is mandatory, you must select a job code before you can set an email to Complete. If job
code selection is optional, you can set an email to Complete right away without selecting a job
code.

Procedure
1. Select the appropriate email.
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2. (Optional) If job code selection is mandatory, select a job code.

3. Click Complete ( ).

Result
Completed emails are stored in the Completed folder. These emails do not appear in your Inbox.

Deferring an email
About this task
If you cannot immediately address a customer email, you can put the email item on hold and then
address it later. When you defer an email, you can set a follow-up date and add notes for yourself.

Procedure
1. Select the appropriate email.

2. Click More ( ).

3. Click Defer ( ).

4. In the pop-up window:

a. Click  and select a follow-up date.

b. Use the arrows to select a follow-up time.

For example, you can set the follow-up time to 12:28 PM.

c. (Optional) Enter a note for yourself.

d. Click OK.

Result
The deferred email is stored in the Delayed folder until the follow-up date. At the specified time,
the email reappears in your Inbox.

Reassigning an email
About this task
You can reassign or delegate an email to another agent or supervisor. You can also delegate an
email to a specific topic.

Procedure
1. Select the appropriate email.

2. Click More ( ).

3. Click Delegate ( ) to reassign the email.

4. In the pop-up window, do the following:

a. Select the appropriate agent, supervisor, or topic from the list.

Email operations

March 2019 Using the Avaya IP Office Contact Center Web Interface 47
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the Avaya IP Office Contact Center Web Interface


You can use the Search field to help you find a specific name.

b. (Optional) Enter a note or instructions.

c. Click .

Result
Reassigned emails no longer appear in your Inbox.

Chat operations
You can perform the following tasks from the Chat screen if you enable chat when you sign in to
your agent groups:

• View unread instant messaging (IM) notifications. When you receive a new IM, you can see a
visual notification in the UI.

• Respond to an IM from a customer. Agents cannot start a new IM conversation.

• Work with multiple IM conversations at a time. The default is three.

• Use spell check.

• Add emoticons or smiley faces in an IM conversation.

• Print an IM conversation.

• View customer details during an IM conversation.

• View completed or archived conversations.

• Perform a chat consult.

• Transfer a chat conversation.

• Access customer history.

Replying to a chat conversation
About this task
Use this procedure to reply to an IM from a customer. New, unread customer conversations have
a blue indicator. You can work with multiple conversations at a time.
During an IM conversation with a customer, you can access available customer details and take
notes about your current interaction. For more information about customer details, see Working
with customer details on page 35.

Procedure
1. On the left side of the Chat screen, click the Assigned chats tab.

2. Select the appropriate IM conversation.
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New, unread conversations are automatically activated when you select them.

3. Type a message.

Tip:

When you copy text from documents, such as Microsoft Word or PDF documents,
some characters, such as single or double quotes, might not appear properly. If you
copy text, retype these characters manually before sending your IM.

4. To send your IM, do one of the following:

• Click .

• Press Enter on your keyboard.

Related links
Enabling and disabling spell checks for chat on page 50

Starting a chat consultation
About this task
You can perform a consultation during a chat conversation to obtain the information you need to
address a customer issue.

Procedure
1. During an active chat conversation, click .

2. In the dialog box that is displayed, do one of the following to start a consultation:

• From the Internal tab, select an agent.

• From the System tab, select a topic.

• From the Manual tab, in Enter Jabber ID, type the chat ID of an external user and click
.

The consultation session is added to the original chat conversation.

3. (Optional) Click the appropriate option to toggle between the original chat conversation
and the consultation session.

Chat transfers
You can transfer the chat to:

• The same user with whom you have a chat consultation.
• Another agent, topic, or external user if you are not on a chat consultation.

Chat operations

March 2019 Using the Avaya IP Office Contact Center Web Interface 49
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the Avaya IP Office Contact Center Web Interface


Transferring a chat conversation to the user with whom you have a
consultation

Procedure
1. Start a chat consultation as described in Starting a chat consultation on page 49.

2. If your administrator has configured mandatory or forced job codes, click  to select a job
code.

3. To complete the transfer, click .

Result
The chat is transferred along with its history, for reference.

Transferring a chat conversation to any agent, topic, or external user
About this task
This procedure describes how to perform a blind or unsupervised transfer. In this case, a
consultation is not established beforehand.

Procedure
1. During a chat conversation, click .

2. In the dialog box that is displayed, do one of the following:

• From the Internal tab, select an agent.

• From the System tab, select a topic.

• From the Manual tab, in Enter Jabber ID, type the chat ID of an external user and click
.

Result
The chat is transferred along with its history, for reference.

Enabling and disabling spell checks for chat
About this task
You can enable and disable the spell check functionality during an IM conversation.

Before you begin
Ensure that you have internet access.

Procedure
1. On the left side of the Chat screen, click the Assigned chats tab.

2. In the IM conversation, use the  and  buttons to enable or disable the spell check
functionality.
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Related links
Replying to a chat conversation on page 48
Setting the appropriate language for spell checks on page 51

Setting the appropriate language for spell checks
Before you begin
Ensure that spell check is enabled for chat.

Procedure
1. In your browser, do the following:

a. Set the appropriate language.
b. Select the Use this language for spell checking check box.

2. In the IP Office Contact Center Web User Interface, to ensure that the appropriate
language is set, do the following:

a. Right-click an empty area to view detected spelling errors.
b. From Spellcheck, ensure that the correct language is selected.

Ending a chat
About this task
After an issue is resolved, use this procedure to complete or end the chat conversation. After you
end a conversation, you cannot reopen it.

Note:
After the customer or consulting agent leaves the chat conversation, you must end it in order
to become available for other chat tasks.

Procedure
1. On the left side of the Chat screen, click the Assigned chats tab.

2. Select the appropriate IM conversation.

3. At the top right of the IM conversation, click End chat.
4. In the pop-up window do the following:

a. Select one of the available job codes.

If the topic is configured to use job codes, you can search for a specific job code using
the Search field.

b. Click  to submit your selection.

Result
Completed conversations are stored in Archived chats. These conversations are removed from
Assigned chats.
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Searching for archived conversations
About this task
After you end an IM conversation, the conversation is stored in the Archived chats tab. You can
search for any archived IM conversation on your server.

Note:
If you do not replace copied characters, such as single and double quotes, then the
conversation that contains these characters might not appear in the Archived chats tab.

Before you begin
You must have the “Advanced archive view” privilege.

Procedure
1. In the Chat screen, click the Archived chats tab.

2. Use the first drop-down menu to filter conversations by date.

You can view conversations from:

• Today. This option is set by default.

• The last 7 days.

• The last 15 days.

• The last 30 days.

3. (Optional) In the Search field, type the appropriate keywords.

For example, you can enter a topic name to find IM conversations related to that topic.

4. (Optional) To search for a specific agent’s conversations, select the agent from the drop-
down menu below the Search field.

5. Select the conversation you want to view.

The conversation appears on the right side of the screen.

Related links
Replying to a chat conversation on page 48

Email and chat
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Part 2: Supervisor operations
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Chapter 7: Real time information

This chapter describes what supervisors can do using the Realtime Information module.

The Realtime Information screen contains the following tabs:

• Agents

• Groups

• Topics

• Queue

• Other

You can click on an item in the tabs to expand it. Some of the agent and group information provided
is also available to agents. For a detailed description of agent statistics, including break and work
time statistics, see the “Agent operations” part in this document.

You can access additional configuration options for the Realtime Information module from the IP
Office Contact Center User Interface for Windows.

Viewing agent and group information in real time
About this task
Real time monitoring enables you to manage agent actions and perform customer service tasks
when needed.

Note:
As a supervisor, you can have a maximum total of 25 agents in the combined groups for which
you are authorized.

Procedure
• (Optional) On the Home screen, send a message to agents if required.

You can also sign in to agent groups to pick up calls from the queue or to perform other agent
tasks.

• Click  and select Realtime information.

• To view and update information for a specific agent, click the Agents tab.
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You can:

- Search for an agent or work state.

- View agent work states and break information. You can also force an agent to take a break
or sign out.

- View the agent groups that the agent is signed in to.

- View the channels that the agent is signed in to. The available channels are telephony,
email, and chat.

The following is an example of the type of information that is displayed in the Agents tab:

• To monitor an agent group:

1. Click the Groups tab.

2. Expand the group that you want to view in detail.

For each group, you can see the agents that are signed in to each channel. You can
view additional information, including the status of each agent, when you expand a
group.

• To view information about topics, including waiting calls in the queue and abandoned calls,
click the Topics tab.

For each topic, you can see the longest and average wait times, an abandoned call monitor
for telephony, a service factor indictor, and the total number of tasks (calls, emails, or chat
conversations). Queue and Abandoned Calls tabs are also displayed. The Abandoned Calls
tab shows calls dropped by the customer under Abandoned Calls, and calls dropped by IP
Office Contact Center based on the task flow configuration under Call Dropped. By default,
the task flow is configured to drop calls if the queue is full.

The following example shows the telephony information available for a topic:

Viewing agent and group information in real time
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Related links
Signing in and out of agent groups on page 31
Agent work states on page 32
Agent break and work statistics on page 34

Assigning calls from the queue
About this task
As a supervisor, you can assign a waiting call to yourself or to another agent. To answer calls
yourself, you must be signed in to an agent group and your status must be “Available”. Otherwise,
the Pick button will be disabled. When a call is directed to a specific group, the call will
automatically be assigned to an available user in that group.
Use this procedure to assign a call from the queue to an available user in another group.

Procedure
1. Click  and select Realtime information.

2. Click the Topics or Queue tab.

The Topics tab enables you to see the waiting calls for a specific topic. The Queue tab
shows all waiting calls.

3. To assign the call to another user, select the appropriate user from the Assign to drop-
down menu.

Real time information
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You can only assign a call to an available user. If no users are available, the drop-down
menu will be empty.

Related links
Answering calls on page 39

Monitoring an agent call silently
About this task
As a supervisor, you can silently monitor calls anytime. You do not need the “Silent Monitoring”
privilege to perform this task in the IP Office Contact Center Web User Interface.

Note:
The Silent Monitoring option only becomes available after the agent's first call.

Procedure
1. Click  and select Realtime information.

2. To monitor agent calls silently, click  from the Agents, Groups, or Queue tab.

Result
The agent and customer cannot hear you when you silently monitor the call. However, depending
on the IP Office configuration, they might hear a beep when the call is being monitored.

Joining a call when an agent requests emergency
assistance

About this task
As a supervisor, you can join a call when an agent requests emergency assistance. You do not
need the “Supervisor Emergency” privilege to perform this task in the IP Office Contact Center
Web User Interface.

Note:
The Emergency option only becomes available after the agent's first call.

Procedure
After an agent requests emergency assistance:

1. Click the  indicator on the left side of your screen and use the menu that is displayed
beside the indicator to select the notification.

You are directed to the Realtime Information screen.

Monitoring an agent call silently
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2. Click the glowing  indicator to join the call.

Important:

You cannot join the call if it is on hold. Agents should not put the call on hold when they
request emergency assistance.

Result
When you join the call, it becomes a three-way conference between you, the agent, and the
customer. If you drop from the call, the agent and customer still remain connected.

Viewing variables
About this task
Administrators can configure variables in the Web UI tab of the IP Office Contact Center User
Interface for Windows UI Configuration module. Use this procedure to view these variables in the
IP Office Contact Center Web User Interface. You cannot edit variables in the IP Office Contact
Center Web User Interface.

Procedure
1. Click  and select Realtime information.

2. Click the Other tab.

The UI displays a list of variables.

Real time information
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Chapter 8: Reports

You can view and generate manual historical reports from the Reporting tab. The reports record,
examine, assess, and present all important IP Office Contact Center system data.

Advantages of reporting
You can use Reporting to:

• Ensure continuous quality of service.
• Identify peak times that can be counteracted by proper coordination among contact center

personnel.
• Evaluate performance and calculate expenses for the time needed to process a call or email.
• Use the information from reporting evaluations as a basis to assess and respond to seasonal

events or increase in customer requests.
• Record feedback about promotions and marketing measures.

Report types
You can activate reports for two different user groups:

• Private: You can enable private reporting for the user who defined the report.
• Public: You can enable reporting as public, so that all users with privileges can view the

configured report type.
You must define a time frame for the report survey. The options are months, weeks, days, total
period, and a user-defined time in hours and minutes.
The report is displayed in the following formats:

• Tabular format: The report displays as a table. The order of events is organized based on
custom groupings.

• Graphical display: The report displays as a line graph, bar chart, or pie chart. This display is
not available for all agent groups and topic counters.

In the report view, you can use the toolbar to directly export, print, and send reports through
emails.
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Viewing existing reports
About this task
Use this procedure to view reports that you generated in the past.

Note:
If the administrator updates a report, then the previous version of the report is overwritten. The
new version of the report is displayed. The old version is no longer displayed.

Before you begin
Ensure your administrator configures the setting Use basic data period/output only in the IP
Office Contact Center User Interface for Windows for each report. Otherwise, the reports will not
be displayed in the user interface.

Procedure
1. Click  and select Reporting.

2. Select View Report.
3. To find the appropriate report, in the Choose a Report screen, do one of the following:

• Enter a key word in the Search field.

• Scroll down through the list of all reports.

The system displays the selected report on the right side of the screen.

4. To change the report view, click Previous Report Viewer.
5. To view the report in full screen mode, click Expand ( ).

Tip:

If you click Previous Report Viewer and then expand the report, the previous report
view is lost. You must click Previous Report Viewer again.

Generating a report
About this task
You can generate a report using one of the available report types.

Procedure
1. Click  and select Reporting.

2. Select Run Report.
3. To find the report, in the Choose a Report screen, do one of the following:

• Enter a key word in the Search field.

Reports
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• Scroll down through the list of all reports.

4. To set the specifications for your report, do the following:

a. Select a start and an end date, and a time.

b. If you want to limit the days and times for which reports are generated, select the
appropriate options in Only Report.

5. To create a new report, click Generate Report.

The system displays a status bar in the View Report field indicating the progress of the
report.

Managing and exporting reports
About this task
This procedure describes how to:

• Download a report
• Print a report
• Change the font settings of a report
• Export a report
• Email a report

You can access these options from the View Report tab. Some of these options are only visible
after the report preview loads.

Procedure
1. Select a report from the left pane.

2. To download the report, click Download ( ).

3. To print the report, click Print ( ).

4. To change the font size for the report, select an option from the Font drop-down menu in
the report preview pane.

5. Select one of the following options from the report preview pane to export a report:

• : To export the report in PDF format.

You can use the drop-down menu to specify the PDF orientation or you can select Auto.

• : To export the report as an image in PNG format.

• : To export the report as an Excel spreadsheet.

• : To export the report in CSV format.

Managing and exporting reports
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6. To send the report in an email, do the following:

a. Click .

Use the following steps to complete the information in the E-mail dialog box.

b. Specify the format for the report.

If you selected PDF, you can select a size. If you select A3 or A4 from the Size drop-
down menu, you can also choose to select the Landscape check box.

c. Enter a recipient email address and then click Add.

You can add multiple recipients.

d. Click OK when you are ready to send the email.

Reports
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Chapter 9: Agent status and contact detail
reports

In addition to the standard Reporting module, supervisors can also access the Agent Status Reports
and Contact Detail Reports modules. For more information, see Avaya IP Office Contact Center
Reporting Task Based Guide.

You can create or export reports in the following formats:

• PDF

• CSV

• Excel

You can view Agent Status Reports and Contact Detail Reports in all browsers.

Agent Status Reports module: 

Agent Status Reports provide a statistical evaluation of agent activities. You can use this module to
track when and how often agents sign in, sign out, and take breaks. You can also view presence
information and break times for one or more agents. In counter-based reports, you can only
evaluate presence and break times.

Contact Detail Reports module: 

Contact Detail Reports provide a statistical evaluation about all task types, which include Telephony,
Email, and Chat. This module provides information about callers, dialed topics, conversation
lengths, and agents involved with each task type. Counter-based reports provide only summary
values, such as the number of calls, number of conversations, total conversation times, and average
conversation times.

The following table summarizes the areas of application available with the Contact Detail Reports
module:

Option Description
Invoicing for customers (inbound) Invoicing is based on services rendered.

Table continues…
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Option Description
Reporting user processes This option provides information about:

• How customers communicate with the IP Office Contact Center
system.

• The topics and agents that are involved.

• How long customers communicate and with whom.
Detailed task type processes Processes are broken down by task type for each IP Office Contact

Center agent.

Agent status report data
The following table describes all possible agent status report data. The UI does not display all of
this data by default. To modify the data that is displayed, you can click on the column header, and
then from Columns, select the data that you want to see.

Column name Description
Agent name Displays the name of the agent associated with the agent activity.
Start time stamp Displays the date and time. The system records all agent activity with a time stamp.
Login/logout Specifies whether the agent is logged in or out of the system regardless of the task

type.
Sign on/sign off Specifies whether an agent is signed in or out of an agent group.

Note:

Agents are also signed out if they do not answer a call, email, or IM within the
configured timeout period. In this case, Sign on/sign off displays Sign Off
(RONA) for the agent.

Break Time Specifies whether an agent is on a break.

If the agent takes a break and signs out of an agent group, Break Time on is
displayed. If the agent signs in after the break, Break Time off is displayed.

Wrap Up without
call

Specifies the status of manual wrap-up time, which is started by the agent manually
and is independent of a call.

Additional info Displays additional information when an activity starts.
Task type Displays the task type.

Contact detail report data
The following table describes all possible contact detail report data. The UI does not display all of
this data by default. To modify the data that is displayed, you can click on the column header, and
then from Columns, select the data that you want to see.

Agent status and contact detail reports
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Column name Description
Voicemail is
recorded

Specifies whether the contact started with a voice mail message being recorded.

The report can display the following options:

• Yes: Contact begins with recording a voice mail message.

• No: Other.
Contact type Displays how the contact was established with the customer. The options are:

Dialer, ACD, or Other.
Start time stamp Displays the contact start time stamp.
Total duration (s) Displays the duration of the call in seconds. This excludes the wrap up time.
Total duration with
ACW (s)

Displays the duration of the call in seconds, including the wrap up time.

End time stamp Displays the date and time when the contact was recorded as complete. This
excludes the wrap up time.

End time stamp
with ACW

Displays the date and time when the contact was recorded as complete. This
includes the wrap up time.

Task type Displays the task type.
Caller/Sender Displays the caller number, email address, or chat ID.
Selected address Displays the telephone number, email address, or chat ID that is selected by the

caller.
Original topic Displays the name of the topic that first handled the caller.
Initial Interaction Displays the initial contact connection status with the following details:

• ConnectedDirect: Connected without a queue.

• ConnectedQueued: Connected with a queue without an announcement.

• ConnectedQueuedAnnounce: Connected with a queue and an announcement.

• DroppedOverload: Disconnected by the system due to overload.

• DroppedBusy: Disconnected by the system because the system is busy.

• DroppedCanceled: Disconnected by the system by a call flow.

• AbandonedAlerting: Disconnected by the caller during a call.

• AbandonedQueued: Disconnected by a caller in the queue without an
announcement.

• AbandonedQueuedAnnouncement: Disconnected by a caller in the queue
with an announcement.

• Callback: Call back according to the queue position.

• Rejected: Wrong number dialed by an agent for an outgoing topic call.
Number of
customer records

Displays the number of customer records that were matched with the caller using
the customer configuration.

Table continues…

Contact detail report data

March 2019 Using the Avaya IP Office Contact Center Web Interface 65
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using the Avaya IP Office Contact Center Web Interface


Column name Description
Interaction time (s) Displays duration of the call, email or chat conversations in seconds. This

excludes the time when the call was on hold.
Hold time (s) Displays the total hold time in seconds.
Wait time (s) Displays the total waiting time in seconds. This includes the time spent on IVR,

ringing, and queue.
Alerting time (s) Displays the total time in seconds spent on call ringing, chat, and email alerts at

the destination.
Queue time (s) Displays the total time in seconds spent on IVRs and announcements.
Number of
customer records

Displays the number of connecting legs that define the contact.

Number of
customer
connections

Displays the number of connecting legs, which have an established connection
with the customer.

Chargeable time (s) Displays the total time in seconds spent to complete a call on a chargeable
number.

Number of
consultations

Displays the number of consultations or transfers that define the contact.

Number of
consultation calls

Displays the number of consultation calls or supervised transfers that define the
contact.

Consultation
speech time

Displays the total time spent on consultation calls. This excludes the hold time.

Wrap up time (s) Displays the time in seconds spent on completing the post call work.
Direct topic dial in
contact

Specifies whether the subscriber selected the topic. Also, indicates whether the
contact was inbound or outbound.

External contact Specifies whether the contact is external or internal.
Inbound contact Specifies whether the contact is inbound or outbound.
OutCC contact Specifies whether the contact is an outgoing call center call.

The report can display the following options:

• Yes: Contact was an outgoing call center call.

• No: Other.
Dialer contact Specifies whether the contact is established using the Dialer functionality.

The report can display the following options:

• Yes: Contact established using dialer.

• No: Other.

Additional details
You can click  in the new viewer or  in the old viewer to view additional details.

Agent status and contact detail reports
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The following additional details are provided:

Type of information Details displayed
Connections information • Details

• Start time stamp

• Caller/Sender

• Caller/Sender Name

• Customer number

• Customer priority

• Selected address

• First topic

• Last topic

• Task type

• Initial Interaction (connection status)

For more information about initial interaction connection status details,
see Initial Interaction on page 65.

• Call time

• Speech or active time

• Wait time

• Time on hold

• Chargeable time of connection

• Wrap up

• Consultation

• Routed

• Voicemail is recorded

• Dialer contact

• Network overflow
Topic Information • Start time stamp

• Topics

• Destination name

• Wait time

• Announcement

• Announcement script

• IVR script

• Welcome announcement
Table continues…

Contact detail report data
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Type of information Details displayed
Destination Information • Start time stamp

• Destination name

• Destination

• Destination type

• Agent group

• Topics

• Wait time

• Ring time

• Speech-/active time

• Time on hold

• Wrap up

• Job Codes

Agent status and contact detail reports
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Appendix A: Resources

Documentation
Document title Use this document to Audience
Overview
Avaya IP Office Contact Center
Feature Description

Understand IP Office Contact
Center features and capabilities.

All users

Planning
Avaya IP Office Contact Center
Reference Configuration

Understand IP Office Contact
Center deployment topologies,
network architecture, system
capacities, product
interoperability, and functional
limitations of specific
configurations.

• Sales and support personnel

• Architects

• Implementation engineers

Administering
Using the Avaya IP Office Contact
Center Configuration and User
Interface Configuration Modules

Perform administration tasks with
the Configuration and UI
Configuration modules.

Note:

This document is also
available as a help system
through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center Dialer

Work with the Dialer module in
the IP Office Contact Center
interface.

Administrators

Using
Using Avaya IP Office Contact
Center for Windows

Use the IP Office Contact Center
User Interface for Windows.

All interface users, including
agents, supervisors, and
administrators.
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Finding documents on the Avaya Support website
Procedure

1. Navigate to http://support.avaya.com/.

2. At the top of the screen, type your username and password and click Login.

3. Click Support by Product > Documents.

4. In Enter your Product Here, type the product name and then select the product from the
list.

5. In Choose Release, select an appropriate release number.

6. In the Content Type filter, click a document type, or click Select All to see a list of all
available documents.

For example, for user guides, click User Guides in the Content Type filter. The list
displays the documents only from the selected category.

7. Click Enter.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos
posted on the website.

Resources
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Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Using the Avaya InSite Knowledge Base
The Avaya InSite Knowledge Base is a web-based search engine that provides:

• Up-to-date troubleshooting procedures and technical tips

• Information about service packs

• Access to customer and technical documentation

• Information about training and certification programs

• Links to other pertinent information

If you are an authorized Avaya Partner or a current Avaya customer with a support contract, you
can access the Knowledge Base without extra cost. You must have a login account and a valid
Sold-To number.

Use the Avaya InSite Knowledge Base for any potential solutions to problems.

1. Go to http://www.avaya.com/support.
2. Log on to the Avaya website with a valid Avaya user ID and password.

The system displays the Avaya Support page.
3. Click Support by Product > Product Specific Support.
4. In Enter Product Name, enter the product, and press Enter.

5. Select the product from the list, and select a release.
6. Click the Technical Solutions tab to see articles.
7. Select relevant articles.

Support
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Glossary

After Call Work mode A mode in which agents are unavailable to receive calls. Agents enter the
After Call Work (ACW) mode to complete forms, select job codes, or
perform other activities that are related to a previous call.

agent An agent who typically handles customer service tasks. A user can be
associated to an agent. Only agents can receive tasks from call center
routing. An agent can log in to one or more specific media types. The
agent media states are independent of each other. For example, an agent
can be signed on for email and signed out for voice. Agents can belong to
one or more agent groups.

agent group A tool for categorizing and organizing agents. Agent groups are used as
routing targets for customer calls and emails. The UI tracks customer
service statistics for agent groups. Skills are allocated to agents in agent
groups, and calls can be routed to agents based on their skills. An agent
can be part of multiple agent groups. Agents must sign on to an agent
group to receive calls that are routed to that group.

Automatic Call
Distribution

A programmable feature at the contact center. Automatic Call Distribution
(ACD) handles and routes voice communications to queues and available
agents. ACD also provides management information that can be used to
determine the operational efficiency of the contact center.

module An IP Office Contact Center component or application. The components
for the Agent, Supervision, and Administration tabs in the IP Office
Contact Centerinterface are examples of modules. The Wallboard
application is also referred to as a module.

Task flow A process that explains how each telephony, voice, email, or chat task
type is processed within IP Office Contact Center. For every task type, a
task flow set can be defined.

user Agents, supervisors, or administrators that can log in to the IP Office
Contact Center UI to use or administer parts of the system. Unique
privileges can be assigned to each user.

Wrap-up time The time that a call center agent spends completing a transaction after
the call is disconnected. Wrap-up time starts automatically and includes
work directly associated with the call, such as taking notes or selecting
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job codes. The time does not include time spent in meetings, breaks, or
correspondence.

Wrap-up time
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